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Camtasia Studio Overview and Flash 
Video Tutorial 

This book gives a basic overview of Camtasia Studio. This book also includes a tutorial that teaches how to create an 
interactive Flash video ready for upload to the Web using Screencast.com.  

• The media files used with the tutorial are included with the installation of Camtasia Studio.  
• This tutorial is for a beginner level. No prior knowledge of Camtasia Studio or video editing is necessary. 

 

When the tutorial is complete, you will have 
• Made an interactive Flash video containing three separate “chapters”.  
• Added Voice Narration. 
• Included Callouts and Transitions.  
• Produced the video using the Production Wizard.  
• Created an iPod version of the video along with an MP3 file of the audio. 

 

Before You Begin 
Before you begin the tutorial, we recommended reading the first chapter entitled Camtasia Studio 4.0 Overview on 
page 4. This overview chapter contains important information about the different components of the Camtasia Studio 
interface, the names of tools and buttons, and specific terminology relating to video production.  

To begin the tutorial, continue with Import Media on page 23. 
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Camtasia Studio 4.0 Overview 
When you first begin to work within Camtasia Studio, you are in Timeline or main view. Several different components 
reside within the main view: Task List, Task Area, Preview Area, etc.  

Before you begin to use Camtasia Studio, take a few minutes to familiarize yourself with the Timeline view and its 
components.  

 

 
Menu Bar. Access all dropdown menus from the menu bar.  

 
Task List pane. Begin most tasks by selecting an option within this pane. To access any task, click on a task 
with the mouse cursor. See Task List and Task Area. 

 
Clip Bin. Media files are stored here for easy access. Drag a clip from the Clip Bin to the Timeline to include 
it in the video. Clips in the Clip Bin are saved with the project when the project is saved. See also: The Clip 
Bin. 

 
Main Toolbar. Access several commonly used options here. See also: Main Toolbar. 

 
Preview Area. Double-click on a clip in the Clip Bin or Timeline to preview it. 

 Playback Controls. Use the controls to move throughout the Timeline. Grab the scrubber control  within 
the Preview Area and drag it to a particular location in the video.   

 
Timeline Toolbar. Used to add Transitions, splitting the video, making cuts, adding audio tracks, and 
adjusting volume. See Timeline Toolbar. 

 
Timeline. Clips are placed on the Timeline for inclusion in the video. See Import Media. 
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Main Toolbar 
Several of the most-used options appear in the Camtasia Studio main toolbar. 

 
Each time the cursor touches a button, a tooltip appears showing the name of the tool. 

Button Tool Name Description & Use 

 

New Project Begin a new Camtasia Studio project. 
If you are currently working on a project and you have not saved, a prompt appears 
to save.  

 

Open Project Open an existing project.  
Find the project to open. Click Open.  

 

Save Project Save the project including all effects, Transitions, and project settings.  

 

Import Media Files Show the Open dialog box used to choose the media files to import. 
Find the media files to use in the video production project. See also: Import 
Media. 

 
Produce Video As Show the Video Production Wizard used to create the video from the project.  

Choose the production options to create the video.  

 

Undo Undo the last action in succession. This is an unlimited undo. 

 

Redo Redo the last action in that was undone. This is an unlimited redo. 

 

View Task List Show or hides the Task List. 

 

Tools Give access the other Camtasia Studio applications.  
Choose the application from the list.  

 

Help Open the Camtasia Studio online help. 
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Timeline View 
The Timeline view is the primary working view since most of the editing work is done here. Use the Timeline to 
assemble video recordings made using Camtasia Recorder or from some other source as well as other forms of media 
such as still images and audio files.  

Collectively, the media files placed on the Timeline are called clips. On the Timeline, the timing of each clip is 
controlled, clips are added or removed, frames are edited, sound is added, and much more. This is also where Quizzes, 
Callouts, and Zoom effects are added to the video. These special effects and enhancements, called Elements , are 
represented on the Timeline as different colored icons. 

When Camtasia Studio is first started, the Timeline is empty. To add clips to the Timeline, drag a clip from the Clip Bin 
and drop it on the Timeline.  

Below is an overview of the different parts of the Timeline and example clips and elements. 

 

 
Timeline Toolbar. Clip or split the video, adjust the sound, zoom in or out on the clip for a better view, or 
to see additional tracks.  

 
Seek Bar. Moves along as the content of the Timeline plays. Wherever the seek bar is located on the 
Timeline, that area has focus in the Preview Area.  
Drag the seek bar to select portions of the video to edit. The selection is highlighted in blue.  

 
Time Reference Status Area. Shows the time that the seek bar is referencing within the video. Use this 
area to keep track of the overall time of the total video. 

 
Caption Track. Shows each Caption that you create on the Timeline. A small portion of the caption 
appears. Double-click on a Caption to access the Caption Properties task page. 

 
Video and Audio 1 Track. Shows the main video(s) clips and any audio associated with those clips. All 
audio appears as a wave form.  

 
PIP Video and Audio Track. Shows the PIP video(s) clips and any audio associated with those clips. All 
audio appears as a wave form. Double-click on a PIP clip to access the PIP Properties task page. 

 
Audio 2 Track. All additional audio added to the Timeline appears on the Audio 2 track. All audio 
appears as a wave form.  

 
Lock Icons. To the left of each track are tiny icons used to lock a track. Locking a track prevents the 
editing or changing of the clips or elements on that track. 

 
Special Effects and Enhancement tracks. Zoom and Pan keyframes, Callouts, Quizzes, etc. appear on 
their own tracks. These elements are attached to the main video track. Therefore, if you move a clip on the 
Video track, these elements remain with that clip in their correct location.   
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Timeline Toolbar 
This table describes each of the Timeline Editing tools along with its description and use. 

Button Tool Name Description & Use 

 
Zoom In Zoom in on the Timeline showing a closer look at the video.  

 
Zoom Out Zoom out on the Timeline. When fully zoomed out, the entire video is 

seen on the Timeline.  

 
Cut Selection Delete the selection from the video. 

 
Split Video Split the video at the point of the selection seek bar.  

 
Show Storyboard This is a toggle button. When in Timeline view, it opens the Show 

Storyboard button. Continue with Storyboard View 

 
Show Timeline This is a toggle button. When in Storyboard view, it opens the Show 

Timeline button. Continue with Timeline View. 

  
Fade In Fade in the volume of the clip on the audio track.  

 
Fade Out Fade out the volume of the audio track. 

 
Volume Up Increase the volume of the audio track. 

 
Volume Down  Decrease the volume of the audio track. 

 
Replace with 
Silence 

Replace the audio selection with silence. 

 
Audio 
Enhancements 

Open the Audio Enhancements task page. 

 
Tracks Turn the Timeline tracks on or off. Click the down arrow next to the 

Tracks button. From the flyout menu, choose the track to turn on or turn 
off.  

 
Timeline Help Access the help system for assistance on using the Timeline features. 

 
Time Increments Shows the time on the Timeline in various increments depending upon 

the zoom level.  
As the Zoom In and Zoom Out buttons are used, the Timeline reflects 
the new time increments. This is read-only information. 

 

Seek Bar The seek bar moves along as the contents of the Timeline play. Wherever 
the seek bar is located on the Timeline, that area has focus.  
Drag the seek bar to select portions of the video to edit.  
The portion of the clip selected for editing is highlighted in blue.  
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Storyboard View 
In the Storyboard view, the Storyboard prominently appears at the bottom of the screen. And, just like the Timeline, 
Camtasia Studio uses the Storyboard to assemble videos that you may have made using Camtasia Recorder or from 
some other source, as well as other forms of media such as still images. Collectively, the items placed on the Storyboard 
are called clips. 

Overall, the Storyboard view is primarily used by those who wish to use unedited clips when creating a produced video. 
When creating a video using clips that do not need to be edited, drag the clips from the Clip Bin to the Storyboard in the 
desired order, add Transitions if desired, and then Produce the video.  

It is important to note that you cannot edit the clips while in Storyboard view. You must be in Timeline view in order to 
edit the clips in any way.  

Below, find an overview of the different components of the Storyboard. After loading a clip from the Clip Bin into the 
Storyboard, it changes to reflect the appearance of the clip. The first frame of the video and still images appear as a 
thumbnail image. 

On the toolbar, there is a toggle button . When in Storyboard view, it says Show Timeline. Click to 
move to Timeline view. 

 Note:  If the clip has audio, the audio track is not seen in Storyboard view. You must switch to Timeline view in 
order to see the audio tracks or to edit the video.  

 
 

 
When clips are viewed within the Storyboard, the first frame of a video clip or the actual 
thumbnail of a still image appears. 

 
Toggle button used to switch between Timeline and Storyboard view. Continue with Timeline 
View. 

 
Open the Audio Enhancements task page.  

 
Open the help system. 

 
When Transitions are included in the video, they appear between the clips as a graphic 
representation of the Transitions action.  
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The Clip Bin 
The Clip Bin holds all of the video, audio, and image clips that you import into the project. To put a clip on the Timeline 
for editing, drag it from the Clip Bin down to the Timeline and drop it there.  

It is important to note that: 
• Only clips on the Storyboard or Timeline are included in the production of the video.  
• Clips in the Clip Bin are not affected by any edits that occur on the Timeline. For example, consider a clip on 

the Timeline split in two: this split is not reflected within the original clip residing in the Clip Bin. 
• Editing clips on the Timeline is a nondestructive process and none of the original media files are altered in 

any way. 

Identifying Each Kind of Clip in the Clip Bin 
• The thumbnail image that appears is the first frame of the actual clip.  
• Audio clips are represented by a standard audio icon.  
• Title clips and all other image file clips show a thumbnail of the actual image.  

For examples, see Clips and Elements on the Timeline on page 3. 

Changing the View of the Clip Bin 
Different views help to organize the clips. By default, the Clip Bin view is Thumbnails shown in Groups where a 
pictorial representation of the clips are organized in similar groups. So, all the video clips are grouped together, all the 
audio clips grouped together, etc.  

Right-click on any background white space and choose the view or sorting order from the context menu. From this 
context menu, you can also choose to: 

• Import other media files into the Clip Bin. 
• Show either thumbnails or details of each clip. 
• Sort the clips by name, size, type, dimensions, or duration. 
• Show thumbnails in media category groups. 

 

Adding Clips in the Clip Bin to the Timeline 
Clips in the Clip Bin are ready to be used in the video project. Drag the clip to the Timeline and drop it there. You can 
add as many clips as desired to the Timeline. You can also add repeated instances of a clip to the Timeline.   
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Import Media 
Import media files into the Camtasia Studio Clip Bin. Once a file is in the Clip Bin, it is called a clip.  

1. In the Task List, click Import Media.  

 
2. The Open dialog box appears. Find the folder containing the file(s).  
3. (Optional) Change the existing option within the Files of type field to All media files to import all kinds of 

media at once, rather than by one type at a time. 
4. Use the cursor to select the files. To choose more than one, press and hold down the Control key and select 

multiple files.  
5. Click Open. Clips appear within the Clip Bin ready to be used in the video project.  
6. To add a clip, drag the clip to the Timeline and drop it there.    

 

 
Clips and Elements on the Timeline 
Once you begin to add media clips and elements to the Timeline, the Timeline updates to include their pictorial 
representation. Each type of clip or element has its own specific look or color coded icon.  

This graphic shows what a typical Timeline might look like once you begin to add clips and make edits.  

 
 

Clip and Element Content Menu Options 
The table below shows each of these and gives a description of the options available through double-clicking or right-
clicking on the clip or element.  

Icon Clip/Element Double-click Options Right-click Context Menu Options  

 
Marker 
Shows a green 
diamond. 

Double-click on a Marker icon 
on the Timeline to access the 
Marker Name dialog box.  
 
 

Right-click on a Marker to bring up the 
context menu. Choose from:  
Set Marker Name 
Accesses the Marker Name dialog box. 
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Icon Clip/Element Double-click Options Right-click Context Menu Options  
Use the Marker Name dialog 
box to enter a name for a 
Marker. The name that you 
enter here appears within the 
interactive Index in the 
produced video. 
See also:  
Add a Marker 
Delete an Element from the 
Timeline 

Move to this Marker 
Move the seek bar to this Marker’s location. 
Delete from Timeline 
Deletes the Marker.  

 
Video Clip  
Shows the first frame 
of the video clip. 

No options available. 
 

Right-click on a video clip to bring up the 
context menu. Choose from: 

 Split  
Splits the video at the point of the selection 
seek bar.  

 Cut Selection 
Delete the selection from the video. 
Extend Frame 
Extend the duration of a frame. The Extend 
Frame dialog box appears.  
Select the duration for the frame in seconds 
by using the arrow buttons. 
Clip Speed 
Speed up or slow down the playback time for 
a clip in the rendered video. 
Image Duration 
Increase or decrease the playback time for a 
clip in the rendered video. Use the arrow 
buttons to change the duration to the time in 
seconds.  
Delete from Timeline 
Delete the clip from the Timeline.  

 
Transition 
Shows a pictorial 
representation of the 
Transition.  

No options available. 
 

Right-click on a Transition to bring up the 
context menu. Choose from: 
Transition Times 
Choose the time (1-5 seconds) that you want 
the Transition to play.  
Delete from Timeline 
Delete the Transition from the Timeline.  
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Icon Clip/Element Double-click Options Right-click Context Menu Options  

 
Image Clip  
Shows a pictorial 
representation of the 
image.  

No options available. 
 

Right-click on an image clip to bring up the 
context menu. Choose from:  

 Split 
Split the video at the point of the selection 
seek bar.  

 Cut Selection 
Delete the selection from the video. 
Extend Frame 
Extend the duration of a frame. The Extend 
Frame dialog box appears.  
Select the duration for the frame in seconds 
by using the arrow buttons. 
Clip Speed 
Speed up or slow down the playback time for 
a clip in the rendered video. 
Image Duration 
Increase or decrease the playback time for a 
clip in the rendered video. Use the arrow 
buttons to change the duration to the time in 
seconds.  
Delete from Timeline 
Delete the clip from the Timeline.  

 
Title Clip  
Shows a pictorial 
representation of the 
Title Clip.  

Open the Title Clips task page 
for editing. 
Make edits and click OK. 
Important Note:  
Any edits made to a Title Clip 
on the Timeline are not 
updated to the Title Clip in the 
Clip Bin. Instead, the Title 
Clip in the Clip Bin is set to 
“empty” where all of the text 
is removed from it.  

Right-click on a Title Clip to bring up the 
context menu. Choose from:  

 Split 
Split the video at the point of the selection 
seek bar.  

 Cut Selection 
Delete the selection from the video. 
Extend Frame 
Extend the duration of a frame. The Extend 
Frame dialog box appears.  
Select the duration for the frame in seconds 
by using the arrow buttons. 
Clip Speed 
Speed up or slow down the playback time for 
a clip in the rendered video. 
Image Duration 
Increase or decrease the playback time for a 
clip in the rendered video. Use the arrow 
buttons to change the duration to the time in 
seconds.  
Delete from Timeline 
Delete the clip from the Timeline.  
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Icon Clip/Element Double-click Options Right-click Context Menu Options  

 
Audio 
Shows a wave form. 

No options available. 
 

Right-click on an audio clip to bring up the 
context menu. Choose from:  
Delete from Timeline 
Delete the audio clip from the Timeline.  

 
Zoom Key Frame 
Shows a blue diamond 
and a shaded area to 
depict the zoom speed.  

• No shaded 
area equals 
Instant 
speed.  

• Small shaded 
area equals 
Fast speed. 

• Large shaded 
area equals 
Slow speed.  

Opens the Zoom-n-Pan 
Properties task page.  
Make edits and click OK.  
Click Finished to exit. The 
Zoom-n-Pan Key Frame 
updates on the Timeline. 

Right-click on a Zoom Key Frame to bring 
up the context menu. Choose from: 
Modify 
Open the Zoom-n-Pan Properties task page. 
Make edits and click OK. Click Finished to 
exit. The Zoom-n-Pan Key Frame updates on 
the Timeline. 
Delete from Timeline 
Delete the Zoom Key Frame from the 
Timeline.  

 
Flash Quiz 
Shows a purple 
diamond. 

Opens the Flash Quiz 
Manager task page. Make 
edits and click OK. Click 
Finished to exit. The Quiz 
updates on the Timeline. 

Right-click on a Flash Quiz to bring up the 
context menu. Choose from: 
Delete from Timeline 
Delete the Quiz from the Timeline.  

 
Caption 
Shows a blue circle in 
a yellow background 
and part of the text 
from the caption. 

Opens the Callout Properties 
task page. Make edits and 
click OK. Click Finished to 
exit. The Callout updates on 
the Timeline. 

Right-click on a Callout to bring up the 
context menu of available options. Choose 
from:  
Delete caption and text 
Delete the current Caption Point and the text. 
Delete caption point only 
Delete the current Caption Point and leaves 
the text in the scripting text box. 
Delete all captions and text 
Delete all the Caption Points and all of the 
text in the scripting text box. 
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Icon Clip/Element Double-click Options Right-click Context Menu Options  

 
Callout 
Shows a box with a 
shaded area to depict 
the fade in / fade out 
attributes.  

Opens the Callout Properties 
task page. Make edits and 
click OK. Click Finished to 
exit. The Callout updates on 
the Timeline. 
 

Right-click on a Callout to bring up the 
context menu. Choose from:  
Modify 
Open the Callout Properties task page. Make 
edits and click OK. Click Finished to exit. 
The Callout updates on the Timeline. 
Paste Callout 
Paste a Callout at the point of the selection 
seek bar.  
Copy Callout 
Copy selected Callout.  
Move to New Line 
Move Callout to a new Callout track. 
Delete from Timeline 
Delete the Zoom Key Frame from the 
Timeline.  

 Callout Track Each time you create a Callout 
on the same frame, a new 
Callout track is created.  
Use the right-click context 
menu located on the Callout 
track to manage those tracks. 

Right-click on a Callout track to bring up the 
context menu. Choose from:  
Paste Callout 
Paste a Callout at the point of the selection 
seek bar. 
Create New Line 
Create a new line for Callouts. To move a 
Callout to the new line, grab the Callout and 
drag it up or down.  
Remove Empty Lines 
Remove all Callout tracks not being used. 
Consolidate Lines 
Consolidate all Callout tracks so unnecessary 
tracks are removed from the Timeline. 

 
PIP (Picture-in-Picture 
Shows a pictorial 
representation of the 
clip being used.  

Opens the Modify PIP task 
page. Make edits and click 
OK. Click Finished to exit. 
The PIP updates on the 
Timeline. 

Right-click on a PIP clip to bring up the 
context menu of available options. Choose 
from: 
Modify 
Open the Modify PIP task page. Make edits 
and click OK. Click Finished to exit. The 
PIP updates on the Timeline. 
Delete from Timeline 
Delete the PIP from the Timeline.  
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Task List and Task Area 
Camtasia Studio has a hyperlinked Task List for choosing feature, media, and production options. There is also a Task 
Area where the options or properties appear for the feature selected in the Task List.  

   

Use the Task List to: 
• Select specific tasks or processes via hyperlinks. 
• Import media files into the Clip Bin.  
• Get help on some of the most commonly used features of Camtasia Studio. 

 

Use the Task Area to: 
• Add, store, and preview the media clips when in Clip Bin view. Drag clips down to the Timeline for 

placement within the video.  
• Select options and set properties for the task selected in the Task List. 

 
 

 
Task List pane. Click on a task’s hyperlink. The Task Area populates with the available options or 
properties.  

 
Task Area. This area changes depending on the option selected in the Task List. Either drag clips to the 
Timeline or select the necessary options or properties relating to the task.  

 
Clip Bin View. Media files are stored here for easy access. Double-click on a clip in the Clip Bin to preview 
it in the Preview Area. Drag a clip from the Clip Bin down to the Timeline to include it in the current video. 
See also The Clip Bin. 

 
Properties and Options area. When a link is selected in the Task List, the options for that feature show in 
this space called the Task Area. Make the selections and click Finish.  

 
Transitions View. When Transitions are selected in the Task List, the work area appears here. The 
Storyboard also appears. Drag the Transition down to the Storyboard. Click Finish.  
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The Preview Playback Area 
The Preview Area is a very important and integral part of the Camtasia Studio interface.  

• Double-click a clip to preview in the Preview Area before being placed on the Timeline or Storyboard.  
• When moving through the video, the Preview Area keeps pace with the seek bar, allowing the current frame 

to be shown.  
• When Voice Narration is added, clips on the Timeline play in the Preview Area allowing you to narrate in 

real time ensuring perfectly synched audio. 
• When a Callout is added, make any adjustments directly in the Preview Area. 
• When modifying a PIP clip, make the size and location adjustments in the Preview Area. 

 
 

 
Playback Controls. Use the controls to move throughout the clips on the Timeline or Storyboard.  

 
Toggle the Preview Area to Full Screen or Undocked Mode.  

 
Preview Area. All videos, still images, and audio clips show in this area when selected in the Clip 
Bin or on the Timeline or Storyboard.  
When in Timeline view, as the clip plays in the Preview Area, the seek bar on the Timeline keeps 
pace with the playback of the clip.  

 
Time Status Bar. This lets you know exactly where the seek bar is on the Timeline in the context 
of the entire video laid out on the Timeline.  
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Playback Control Toolbar Description Table 
This table the options found on the Playback Controls toolbar. 

Button Tool Name Description & Use 

 
Play Plays the video. When the video begins to play, this 

button toggles to Pause. 

 
Pause Pause video.  

 

 
Stop Stop the video from playing. 

Click the Stop button to stop the clip or video.  

 
Previous Clip  Move the seek bar to the beginning of the previous clip 

on the Timeline. 

 
Step Backward Rewind the video frame by frame. 

 
Step Forward Forward the video frame by frame. 

 
Next Clip Move the seek bar to the beginning of the next clip on 

the Timeline. 

 
Time Status Bar Indicates the position of the seek bar within the overall 

video on the Timeline.  
This is a read only field that changes as the seek bar 
moves through the clip or the video.  

 Scrubber  Indicates the playback progress of the video.  
Drag the scrubber to any desired place in the video. 
Drag the scrubber to the place in the video. As the 
scrubber is dragged, the clip or video plays. 
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Basic Timeline Edits 
The Timeline is used to make basic edits to the video and image clips. These basic edits allow you to remove unwanted 
mistakes in the recording, shorten or lengthen clips to accommodate audio, etc.  

It is important to note that original files or clips in the Clip Bin are not affected by any edits that occur on the Timeline.  

Tips 
• When editing, you can undo/redo the editing until you are completely satisfied with the video.  
• Automatically resize a clip on the Timeline by dragging either end of a clip to make the clip shorter. Once a 

clip is sized smaller, drag the end of the clip once again to make it longer. 

 

Use the Timeline to Search the Video  
Searching for specific frames within the video is done several ways: 

• Play the video in the Preview Area using the Play button  on the Playback Controls toolbar. Click the 

Pause button  to pause the video at the appropriate frame. The Timeline updates with the current 
setting. 
 

• Click on the “scrubber” bar within the Preview Area and drag to a particular location in the video. Both the 
Preview Area and the Timeline update with the selected frame. 

 
 

• Use the arrow keys on the keyboard to move the seek bar through the Timeline to the location.  
 

• Click at any video location on the Timeline. The selection seek bar is moved to that location. The frame’s 
time reference appears as a tooltip.  

• As you click on the Timeline, the Preview Area is continually updated with the selected frame.  

 

Lock and Unlock a Timeline Track 
When applying edits to a Timeline selection, the edits are applied to all clips and elements located across all tracks, 
unless specific tracks are locked for editing.  

Example 
There is more than one audio track on the Timeline. When a selection is made on the Timeline, all of the audio tracks 
within that selection are affected by the volume up edits.  

 

To Lock a Track  

Click the Unlock icon  on the Timeline track that you want to lock. The track becomes locked as seen in this graphic.  
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To Unlock a Track  

Click the Locked   icon on the Timeline track that you want to unlock. The locked track becomes unlocked as seen in 
this graphic.  

 
 

Make a Timeline Selection 
Before you can make most edits to a clip(s) on the Timeline, you must make a selection of the area that you want to edit.  

To create a selection to edit: 
1. Hover the cursor over the top of the Timeline where the time increments are found. Notice that the seek bar 

moves along the Timeline with the cursor. 

 
2. Click down and hold the mouse cursor at the point where you want to begin the selection. A red arrow  appears 

on top of the seek bar as seen in the image below.  

 
3. With the mouse cursor still held down, drag the seek bar across the Timeline.  

 
4. Once the selection is made, release the mouse button. The selection remains on the Timeline. 
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Make a Cut on the Timeline  
Cutting deletes unwanted portions of the clip(s) from the Timeline. 

Note:  When making a selection to cut, all clips and elements included in the selection are cut unless you lock the 
specific tracks that contain clips or elements that you do not want to cut. See also Lock and Unlock a 
Timeline Track. 

1. Lock any track(s) that contain clips and elements that you do not want to cut.  
2. Select the range of time to be cut by clicking and dragging the seek bar on the Timeline. The selection is 

distinguished by a blue highlight.  

3. Click the Cut Selection button .  

The selected portion of the Timeline is removed. The Timeline duration is updated and playback of the Timeline in the 
Preview Area immediately reflects the cut(s) that were made.  

Note:  When cutting a clip, the original video is not altered in any way nor is the clip in the Clip Bin affected. 

 

 

Split a Clip on the Timeline 
Splitting a clip divides one clip into two smaller clips making it easy to insert Transitions or graphics between scenes. 
All clips and elements located at the position of the seek bar are split unless you lock the tracks that contain clips or 
elements that you do not want to split. See also Lock and Unlock a Timeline Track. 

1. Lock any tracks that contain clips and elements that you do not want to split.  
2. Position the seek bar at the point where you want to make the split. 

3. Click the Split button .   

 

Tips 
• Images and Title Clips can be split. 
• Callouts and Transitions cannot be split. If attempting to split at a position that contains either a Callout or 

Transition, an error message appears.   

 

 

Add a Marker 
Markers allow you to provide easy navigation points for your viewer. When the video is produced in conjunction with 
the Table of Contents option, the Markers appear as interactive hyperlinks.  

1. On the Timeline, place the selection seek bar on the frame where you want to add a Marker.  
2. Choose Edit > Add Marker or press <CTRL + M>. 
3. The Marker Name dialog box appears. Enter a name and click OK.  
4. A Marker element is inserted on the Timeline within the Markers track. 
5. Double-click on a Marker element on the Timeline to access the Marker Name dialog box once again.  
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Drag a Clip or Element to a New Location 
Dragging a clip or element on the Timeline moves the clip or element to a new location on the same track. 

Note:  Zoom-n-Pan key frames cannot be moved on the Timeline. They must be modified in the Zoom-n-Pan task 
page.  

When dragging a video clip, it cannot be dragged to any arbitrary time on the Timeline. Instead, all clips must form a 
contiguous formation along the Timeline without any gaps. 

When dragging an element, you can drag across clips but you cannot drag past the last video clip on the Timeline. 
1. Click down and hold on the clip or element that you want to move.  
2. Drag the clip or element along the track to the new location. 
3. Release the mouse.  

 

Remove a Clip from the Timeline 
Removing a video or audio clip from the Timeline removes that instance of the clip. The clip still resides in the Clip Bin. 

To remove a video or audio clip from the Timeline: 
1. Click on the clip to be removed to select it. A black border encases the clip. 
2. Click the <Delete> key on the keyboard or right-click on the clip and choose Remove from Timeline from the 

context menu. 

Note:  When removing a clip on the Timeline, you are not altering the original video in any way nor is the clip in 
the Clip Bin affected. 

 

Delete an Element from the Timeline 
Deleting an element such as a Callout or a Quiz from the Timeline permanently deletes that element from the Timeline.  

Note:  Select Undo  to restore an element deleted from the Timeline. However, if you go on to make other edits 
or additions to the Timeline, and then choose to restore an element using Undo, those edits or additions are 
lost during the undo process.  

1. Click on the element to be permanently deleted to select it.  
2. Click the <Delete> key on the keyboard or right-click on the element and choose Delete from Timeline from 

the context menu. 

Note:  Single click on a Zoom-n-Pan key frame to open the Zoom-in-Pan task page. Select the Remove selected 
Zoom-n-Pan keyframe from within the list box on the Zoom-in-Pan task page.  
Or, right-click on the key frame and choose Delete from Timeline from the context menu.   
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Flash Video Tutorial 
This tutorial teaches how to create an interactive Flash video ready for upload to the Web using Screencast.com.  

• The media files used with the tutorial are included with the installation of Camtasia Studio.  
• This tutorial is given at a beginner level. No prior knowledge of Camtasia Studio or video editing is 

necessary. 

Each section of this tutorial is based upon a scenario that addresses common tasks that might need to be performed 
during the creation of a video.  

These sections build upon each other as you go through them sequentially.  

Therefore, it is highly recommended that you begin with the first section and work your way through each subsequent 
section in the order that they appear. After each section is completed, save your project file and use that file as a basis 
for the next section.  

To successfully complete this tutorial, please read and follow the directions just as they are given.  

 

When the tutorial is complete, you will have: 
• Made an interactive Flash video containing three separate “chapters.  
• Added Voice Narration. 
• Included Callouts, and Transitions.  
• Produced the video using the Recommend my Settings Production Wizard.  
• Created an iPod video of the video and an MP3 audio file. 
• An HTML page with an embedded video ready to upload to the Web via Screencast.com. 

 

What you need to know before you begin… 
Before you begin the tutorial, it is highly recommended that you look over the first chapter entitled Camtasia Studio 4.0 
Overview on page 4. This overview chapter contains important information about the different components of the 
Camtasia Studio interface, the names of tools and buttons, specific terminology relating to video production, etc.  

 

To begin the tutorial, continue with Import Media on page 23. 
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Section 1. Import Media Files 
For this tutorial, TechSmith-created media files are used. Each of these files needs to be placed in the Clip Bin. Once 
these have been placed in the Clip Bin, they are referred to as clips. 

The media files include the following:  
• CST1.gif - CST7.gif 
• Coach1.gif - Coach5.gif 
• ChineseArt.gif 
• KoreanArt.gif 
• VietArt.gif 
• Coach.wav 
• Art.wav 

Add Media Files to the Clip Bin 
1. Start Camtasia Studio. The Welcome dialog box appears.  
2. Choose the Start a new project by importing media files option. Click OK.  
3. Find C:\Program Files\TechSmith\Camtasia Studio 4\Tutorials.  
4. Highlight each of the files. Click on the first file, press the <SHIFT> key on the keyboard, use the mouse to 

click the last media file.  

 
5. Click Open.  

The files are now in the Clip Bin: 

 
Continue with Section 2. Add Still Images to Timeline on page 24. 
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Section 2. Add Still Images to Timeline 
Still images can add visual interest to your video. You can use any graphic, clipart image, photo, flowchart, or diagram 
in .bmp, .gif, .jpg, or .png file format.   

 

Fast Facts about Using Still Images 
• Add as many still images as you would like to your video.  
• The default duration time for still images to appear is five seconds. The duration of the image can be 

customized using Tools > Options > Default Duration (In Seconds) > Images. 

 

Scenario 
The image clips are added to the Timeline in a specific order to create different “chapters” in the video. 

 

Add the Still Images to the Timeline 
1. In the order that they are numbered, drag the still images entitled CST1-CST7 onto the Timeline. If you get one 

into the wrong position, grab the image on the Timeline and drag it to the correct place and drop it there. This 
set of images makes up the first chapter in the video. We refer to this chapter as The History of Cinderella. 

2. In the order that they are numbered, drag the still images entitled Coach1-Coach5 onto the Timeline after the 
first set of images. This set of images makes up the second chapter in the video. We refer to this chapter as 
Cinderella’s Coach. 

3. In any order, drag the still images entitled ChinesArt, KoreanArt, and VietArt onto the Timeline after the second 
set of images. This set of images makes up the third chapter in the video. We refer to this chapter as Cinderella 
Art.  

4. Click on the Timeline at the very beginning to move the seek bar to the first position in the video. You see that 
the first still image is updated to the Preview Area. 

5. Click the Save Project tool . Name this project “Cinderella” and click Save.  
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This graphic shows the Timeline after the image clips have been added: 

 
 

That’s it. You have just created a complete video sequence by adding media clips to the Timeline.  

 

Continue with Section 3. Add Transition on page 26. 
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Section 3. Add Transitions 
Transitions are animated effects that create a smooth flow between clips on the Timeline. 

 

Fast Facts about Using Transitions 
• Transitions can only be inserted while you are in Storyboard view.  
• The default duration time for Transitions is three seconds. The duration is customized using Tools > Options 

> Transitions.  
• Transitions can only be placed between clips. You cannot begin or end a video with a Transition.  

 

Scenario 
Transitions are added to the Timeline between image clips. Once the Transitions link is selected in the task pane, the 
Timeline changes to the Storyboard.  

Transitions are placed between the image clips in each chapter - not between the chapters themselves. The two positions 
marked in the graphic below with a red “X” do not need a transition.  

 
 

 

Add the Transitions to the Timeline 
1. Choose Tools > Options. The Options dialog box appears. 
2. In the Program tab, change the Default Duration for Transitions from 3 seconds to 2 seconds. Click OK. 
3. Within the Task List, click Transitions. The Storyboard view automatically appears with the Transitions 

appearing in the Task Area.  

 
4. Double-click a Transition effect to see it play. Test several Transitions to see how they look.  
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5. Once you decide on a Transition, drag it to the Storyboard in the desired location. Once placed on the 
Storyboard, an image depicting the Transition’s effect appear in the placeholder. 

 
6. Continue to add Transitions until each of the placeholders are filled. These can all be the same Transition or 

different ones. 

7. Click Finished .  The Timeline view returns.  

8. Click Save Project .  

 

This graphic shows the Timeline after the Transitions have been added: 

 

Congratulations. Transition effects have been successfully added to your video. Click Play  

to see how it all looks.  

Continue with Section 4. Add Markers on page 28. 
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Section 4. Add Markers 
Markers provide easy navigation points for your viewer. When the video is produced in conjunction with the Table of 
Contents option, the Markers appear as interactive hyperlinks.  

 

Scenario 
Markers are added to the beginning of the three chapters of the video. In the produced video, these allow the viewers to 
jump to the different chapters.   

 

Add the Markers to the Timeline 
1. Click once on the first still image on the Timeline. This moves the seek bar to the beginning of the Timeline. 
2. Press <CTRL + M>. 
3. The Marker Name dialog box appears. Enter “The History of Cinderella” and click OK. A Marker element 

is inserted on the Timeline within the Markers track. 
4. Click once on the first still image in the Coach sequence. The seek bar is moved to the beginning of that 

clip.  
5. Press <CTRL + M>. 
6. The Marker Name dialog box appears. Enter “Cinderella’s Coach” and click OK. Another Marker element 

is inserted on the Timeline. 
7. Click once on the first still image in the Art sequence. The seek bar is moved to the beginning of that clip. 
8. Press <CTRL + M>. 
9. The Marker Name dialog box appears. Enter “Cinderella Art” and click OK. 

10. Click Save Project .  
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This graphic shows the Timeline after the Markers have been added: 

 
 

Great! You have just created a set of Markers for use in your video’s interactive index 

 

Continue with Section 5. Add Callout on page 30. 
 

. 
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Section 5. Add Callouts 
A Callout is a graphic that you can add to the Timeline so when the video is produced, the image appears within the 
video. Callouts are used to “call out” or draw attention to an important object or process being shown on the screen. Or, 
combined with text, they can give additional tutorial or instructional information.  

Turning a Callout into a Flash Hot Spot adds interactivity to a Callout when it is produced as a Flash video. Adding 
interactivity is very nice for making chapters in the video that the viewer can easily jump to, or, for taking the viewer to 
a Website after they have finished watching the video. 

 

Fast Facts about Callouts 
• Callouts come in a variety of shapes and styles. 
• Callouts are customizable, allowing you to change the color, font, opacity, size, text, and more.  
• Create new Callouts by importing your own graphics.  
• A Callout’s duration and position can be quickly changed by dragging the Callout on the Timeline. 

 

Scenario 
Three Callouts with Hot Spots are added to the video. These are placed on the last frames of each of the three chapters 
we have been creating.  

In the produced video, when the Callouts are clicked, the viewer is able to replay a segment of the video. 

Part 1. Add First Callout with Hot Spot Interactivity 
1. Choose Tools > Options. The Options dialog box appears 
2. In the Program tab, change the Default Duration for Callout from 5 seconds to 1 second. Click OK. 
3. Within the Task List, click Callouts. The Callouts task page appears.   
4. Click Add Callout. The Callout Properties task page appears.  
5. Click on the last still image within the History of Cinderella sequence on the Timeline. To do this, click in 

the numbered area above the still image.  
6. Immediately use the right arrow key on the keyboard to move the seek bar toward the end of this clip. Take 

note of the time by looking at the duration in the Preview Area. You want to be right around the 46.78 or 
46.80 second time frame as seen in the following graphic.  

 
This puts the seek bar just before the Marker that was placed on the first frame of the Coach chapter as seen 
in the following graphic. 

 
Note: Use the left arrow key on the keyboard to move back if you have gone too far.  

7. Under Shape, in the Callout Type field, choose the Filled Rounded Rectangle option from the dropdown 
menu.  

8. Change the colors if you desire.  
9. Enable the Make Flash Hot Spot option. Click the Flash Hot Spot Properties button.  

 
10. The Flash Hot Spot Properties dialog box appears. Enable the Pause at end of callout option. Enable the 

Go to Frame at Time option. The default time is set to the first frame. This is correct for this particular Hot 
Spot. Click OK. 

11. Under Text, make the Font: 16, Style: Bold, and Justification: Center.  
12. In the Text field, type “Click to Replay”. 
13. Under Properties, disable the Fade In and Fade Out options. 



Camtasia Studio 4.0                                                                                                                                                                      Create a Flash Video  

Flash Video Tutorial www.techsmith.com •  31 

14. Use the green box located within the Preview Area to place and size your Callout. For our project, we want 
to move the Callout to the bottom right and size it just large enough to accommodate the text.  

15. Click OK. 
16. You are in the Callout Properties task page. 

17. Click Save Project .  

 

This graphic shows where each step is performed. The graphic number coincides with the step number.  

 
 

Continue with Part 2. Copy and Paste the Other Two Callouts on page 32. 
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Part 2. Copy and Paste the Other Two Callouts 
The Callout that was just created is copied and pasted into the last frame of each of the other two chapters of the video. 
Copying and pasting Callouts allows you to get a consistent look in your video and is a very quick way to add more 
Callouts to your video. 

Once the Callouts are pasted, the Go to Frame at Time fields need to be updated to reflect the correct “Go to” time.  

 
1. Within the Callout Properties task page, use the cursor to highlight the Callout that was just created.  

 
2. Click Copy selected Callout.   
3. On the Timeline, move to the last frame in the Cinderella’s Coach section. To do this, click in the numbered 

area above the still image.  
4. Immediately use the right arrow key on the keyboard to move the seek bar toward the end of this clip. Take note 

of the time by looking at the duration in the Preview Area. You want to be right around the 1:19.70 time frame 
as seen in the following graphic.  

 
This puts the seek bar just before the Marker that was placed on the first frame of the Art chapter as seen in the 
following graphic. 

 
Note: Use the left arrow key on the keyboard to move back if you have gone too far.  

5. Once you have the correct frame, click on the Paste Callout option. The Callout is pasted into the video and can 
be seen in the Preview Area.  

6. On the Timeline, move to the last frame in the Cinderella Art section. To do this, click in the numbered area 
above the still image. 

7. Immediately use the right arrow key on the keyboard to move the seek bar to the very end of this clip. Take note 
of the time by looking at the duration in the Preview Area. You want to be right around the 1:39.00 time frame 
as seen in the following graphic.  

 
Once you have the correct frame, click on the Paste Callout option. The Callout is pasted into the video and can 
be seen in the Preview Area. 

8. Click Save Project .  

 

Continue with Part 3. Enter the Go to Frame at Time Fields on page 33. 
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Part 3. Enter the Go to Frame at Time Fields 
Now that the Callouts are pasted into the correct locations, the Go to Frame at Time fields need to be updated to reflect 
the correct times. 

There is now three Callouts in the list box; one original and two copies. The copies are denoted with a number in 
parenthesis. The number one tells you that this was the first one pasted and the number two, the second one pasted.  

 
1. Hover the mouse over the Marker on the Timeline that marks the beginning of the Cinderella’s Coach chapter. 

Write this time down since you will enter it into the Go to Frame at Time field.  

 
2. Double-click on the first pasted Callout. This Callout is associated with the Coach5.gif clip.  
3. The Callout Properties task page appears.  
4. Click the Flash Hot Spot Properties button.  

 
5. In the Go to Frame at Time field, enter the time that you just wrote down. Click OK. 
6. Repeat steps 1-5 for the second pasted Callout.  

7. When done, click Finished .  The Timeline view returns.  

8. Click Save Project .  

 

Your Callouts are located on the Timeline’s Callout track. If you cannot see this track, drag the boundary of the 
Timeline to expand the view.  
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This graphic demonstrates shows the Timeline after the Callouts have been added: 

 
 

Congratulations! You have just created Callouts with interactive Hot Spots.  

 

Continue with Section 7. Add Voice Narration on page 35. 
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Section 7. Add Voice Narration 
Note:  It is necessary that you have a working microphone set up before you can record Voice Narration.  

Voice Narration is used to insert narration into the video using the playback of the clips on the Timeline as your guide. 
When using Voice Narration, the video plays along within the Preview Area while you are recording your voice.  

Once the recording of the narration is complete, the Voice Narration audio clip that you have created is saved as a file 
and inserted into the Timeline at the correct position to correspond to the clip or clips that you were narrating.   

Typically, if you want to narrate the entire video, it is best to wait and do the narration last, after all of the clips have 
been added and edited.  

 

Tips for Successful Voice Recording  
• During recording, it is best to read with an unhurried, natural, and steady voice. 
• While you are recording, the volume sensor shows a colored spectrum of your voice. It is best to record at a 

steady level where the level is somewhere near the middle and where the colors are in the high yellow to 
orange spectrum. If you are recording in the red spectrum, some clipping may occur. 

 

Scenario 
Voice narration is added to the Timeline. Each image clip requires a separate Voice Narration recording. So, altogether 
seven small audio files are created.  

For the narration, read the text off of the image clips as they are presented during playback in the Preview Area. If you 
cannot clearly read the text within the Preview Area, from the menu bar, choose View > Shrink to Fit, to disable that 
option. The text should now become clear in the Preview Area. Simply resize the screen so that all of the text is clearly 
showing. 

If you make a mistake while recording and do not want to save that audio file, choose Cancel within the Save Narration 
As dialog box. Confirm the delete process and then record again.  

 

Part 1. Practice Voice Narration 
1. Click once on the first image clip move the seek bar to the beginning of the Timeline.  
2. Play your video through from the beginning and read the text out loud in a comfortable and natural manner. You 

may have to practice the reading two or three times to get used to the coordination of pressing buttons, watching 
video playback, and reading text all at the same time. Once you feel that you are comfortable with the text itself 
and the timing of the reading, you are ready to record the voice narration.  

3. Make sure that you have a working microphone attached to your PC and that it is in the correct position for 
speaking into.  

You are now ready to begin adding your voice narration. Continue with Part 2. Add Voice Narration on page 36. 
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Part 2. Add Voice Narration 
1. Click once on the first image clip move the seek bar to the beginning of that clip. Click on Voice Narration 

within the Task List. The Voice Narration task page appears.  
2. Enable the Mute speakers during recording option. This prevents any noise coming from your speakers from 

being recorded.  
3. In the Record Track group box, make sure Record to audio track1 option is selected. This ensures that your 

audio becomes properly synched with your image clips. 
4. In the Recording duration group box, make sure Until end of clip is selected.  
5. Now it is time to test your recording volume. Begin speaking out loud to see how loud you must speak to get a 

good recording. The volume sensor shows a colored spectrum of your voice. It is best to record at a steady level 
where the level is somewhere near the high yellow to orange spectrum. If you cannot easily speak that loud, 
simply increase the level of input using the slider in the Input Level field. 
 

6. Now you are ready to record. Click Start Recording . Begin speaking into the microphone, 
reading the text as it appears on the screen. 

7. When the seek bar reaches the end of the first still image, the recoding automatically stops. The Save Narration 
As dialog box appears. Name this recording Cinderella1. 

8. Click Save.  
9. The audio file is automatically updated to the Timeline on the Audio 1 track. 

10. Within the task page, click Finished .  The Timeline view returns.  

11. Click Save Project .  

This graphic shows the location where each step is performed. The graphic number coincides with the step number.  

 
Continue with Part 3. Record the Rest of the Voice Narration on page 37. 
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Part 3. Record the Rest of the Voice Narration 
To record the rest of the clips, repeat steps 1-9 for each image clip located within the History of Cinderella chapter. 
When naming the audio files, change the name to the next successive number, i.e.: Cinderella3, Cinderella4, 
Cinderella5, Cinderella6, Cinderella7.  

This graphic shows the Timeline appears after the Voice Narration audio clips have been added.  

 
 

Congratulations! You have just created the Voice Narration audio files. To see how it all sounds and plays together, 

click Play  in the Preview Area. 

 

Continue with Section 8. Add a Zoom-n-Pan Effect on page 38. 
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Section 8. Add a Zoom-n-Pan Effect 
Zoom-n-Pan is used to zoom in and out on certain areas of the video, calling attention to and allowing your audience to 
see important screen movements or actions that they might not see otherwise.  

The Zoom-n-Pan option works by inserting key frames that tell Camtasia Studio when to zoom in and when to zoom 
out. Key frames are  markers that you place on the desired frames in the video clips. 

Typically, key frames are used in pairs, one key frame to zoom in and one to zoom back out. If only one key frame is 
used and it is set to zoom in, the rest of the video plays back at the key frame’s set magnification until the end since 
there is no key frame giving direction to zoom back out.  

 

Fast Facts about Zoom-n-Pan Key Frames 
• You can add as many key frames to a video as desired. These do not need to be entered all at once but can be 

added as you add clips to the Timeline.  
• Once a key frame is created, you can edit it or delete it.  
• If you choose, you can delete all key frames at one time using the Zoom-n-Pan edit options.  
• Once a key frame is inserted, it appears on the Timeline on the Zoom-n-Pan track.  

 

Scenario 
Set a key frame sequence that zooms in and out on a particular area of a still image clip. The area to be used is in the 
Chinese Cinderella image clip.  

 

Part 1. Move to the Zoom-n-Pan Location 
1. Click on the still image that talks about the Chinese Cinderella. This is the image of the little girl with the fish. 

The seek bar moves to the beginning of the clip. The Preview Area is updated with the still image.  
2. Immediately use the right arrow key on the keyboard to move the seek bar one second into this clip. Take note 

of the time by looking at the duration in the Preview Area. You should be right around the 22 second time 
frame.  

 
You are now ready to add the Zoom In key frame. Continue with Part 2. Add Zoom In Key Frame on page 39. 
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Part 2. Add Zoom In Key Frame 
1. With the seek bar at the 22 second time frame, click Zoom-n-Pan in the Task List. The Zoom-n-Pan task page 

appears. 
2. Click Add Zoom-n-Pan key frame. The Zoom-n-Pan Properties task page appears. 
3. Enable the Custom zoom size option.  
4. Disable the Keep aspect ratio option. 
5. In the Zoom Speed area, choose Fast. This allows the zoom effect to move in quickly. 
6. Scroll down to view the green box. The placement of the green box outlines the area zoomed in on. Move and 

then resize the green box to the area shown in the graphic below. As you resize this box, the zoomed in area’s 
preview appears in the Preview Area. 

7. Click OK. The Zoom-n-Pan task page appears. The key frame appears in the key frame list.  
8. The key frame is also added to the Zoom track on the Timeline. 

9. Click Save project . 

 
 

That’s all there is to it. You have just created a Zoom-n-Pan key frame.  

 

Continue with Part 3. Add Zoom Out Key Frame on page 40 to create the key frame that zooms out.  
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Part 3. Add Zoom Out Key Frame 

1. Click once on the seek bar’s green play head  currently located on the Chinese Cinderella still image. 
2. Immediately use the right arrow key on the keyboard to move the seek bar almost to the end of this image clip. 

Take note of the time by looking at the duration in the Preview Area. You should be right around the 25.60 
second time frame.  

3. Click Add Zoom-n-Pan key frame option. The Zoom-n-Pan Properties task page appears. 
4. Enable the Show Entire Video option. This directs Camtasia Studio to show the entire video when  zoomed out. 
5. Choose Fast in the Zoom Speed options.  
6. Click OK.   
7. The Zoom-n-Pan task page appears. The key frame appears in the key frame list. The key frame is also added to 

the Zoom track on the Timeline. 
8. Click Finished   

9. Click Save Project . 

 

This graphic shows the Timeline after the Zoom-n-Pan key frames have been added: 

 
 

Congratulations. You’ve just created a complete Zoom-n-Pan key frame sequence. To see how it all plays together, just 

play your video using the Play button  in the Preview Area. 

 

Continue with Section 9. Adding Audio Clips as Background Music on page 41. 
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Section 9. Adding Audio Clips as Background Music 
Adding background music is a great way to set the mood for your viewers as they watch your video. There may be times 
as you demonstrate a process or display a diagram on the screen, that there won’t be any narration. In that case, it is nice 
to add a music in the background to give your video a more professional or polished touch.  

When adding background music to your video, add your audio files after you have added all of your media clips to the 
Timeline and have completed all of your edits.  

 

Fast Facts about Adding Audio Files 
• Once an audio file has been placed on the Timeline, you can edit it by adding fade in and fade out sections, 

increasing or decreasing the volume, or by removing portions of the audio altogether.  
• Drag either end of the audio clip while it is on the Timeline to instantly size the audio to fit a particular clip. 
• You can add the same audio loop file repeatedly to the Timeline to get a long playing sound.  
• Audio tracks are placed on the Audio 2 track. 

 

Scenario 
Insert two background audio clips on the Timeline to synch up with the Cinderella’s Coach and Cinderella Art chapters. 

 

Adding Audio Clips to the Timeline 

1. Use the Zoom tool  to zoom in closely on the Timeline.  
2. Find the Coach.wav file in the Clip Bin. Drag it to the Timeline, lining it up with the beginning of the Coach 

section. The audio clip is placed on the Audio 2 track.  
3. Select the Art.wav file in the Clip Bin and drag it to the Timeline, lining it up with the beginning of the 

Cinderella Art section.  

4. Click Save Project .  

 

This graphic shows the Timeline after the audio clips have been added: 

 
 

Good Job. You have just created a background music sequence using two audio clips.   

 

Continue with Section 10. Produce an Adobe Flash Video on page 42. 
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Section 10. Produce an Adobe Flash Video 
Adobe Flash is a cross-platform video file format that plays on any computer that supports the Flash Player. Flash is 
ideal for publishing videos on the Web.  

 

Scenario 
Produce the Camtasia Studio project as a Flash video file using the Recommend my Production Settings. 

Once produced, the video appears in an HTML page. Click Play Screencast to play the video. The MP3 audio file and 
iPod® video file are available for download from links at the bottom of this page. 

 

Produce a Adobe Flash Video File 
1. Choose Produce Video As in the Task List. The Production Wizard Welcome dialog box appears. 
2. Make sure the Recommend my Production Settings option is selected. Click Next.  
3. Distribution dialog box: Choose Web.  
4. At the bottom of this dialog box, enable Create MP3 File and Create iPod File. Click Next.  
5. What type of content does your Timeline include dialog box: Check all that apply. Click Next.  
6. Optimize for file size or video quality? dialog box: Leave default settings. Click Next.  
7. Optimize for file size or audio quality? dialog box: Leave default setting. Click Next.  
8. Flash Templates dialog box: Verify the One video with TOC option is selected. Click Next 
9. Table of Contents dialog box: Leave default settings. Click Next.  
10. Where would you like to save your video files dialog box: Leave default settings. Click Next. 
11. Completing the Production Wizard dialog box: Click Finish. The production process begins. The Rendering 

Project dialog box appears giving a continual status. 
12. Production is Complete dialog box: Choose Yes. I’m ready to share my video over the Web. Click Next. 
13. What would you like to do next?: Choose Upload video to Screencast.com. Click Finish.  

You see the Screencast.com Login Info dialog box. Enter the required information and follow the prompts to upload 
your video. For more information on Screencast.com, see http://www.screencast.com/.  

Congratulations. You have just created your first interactive Flash video. 

 

You have now completed this tutorial. For more in-depth information on each of the features found in Camtasia Studio, 
consult the help file.  

http://www.screencast.com/
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Contact TechSmith Technical Support 
If you have a question pertaining to Camtasia Studio, we recommend that you first search the built-in help file to find the 
information that you need.  

If you still need technical support help, you can get free support by searching our Web site’s support database 
1. Log on to the Internet.  
2. From within Camtasia Studio, choose Help > Support.  
3. Select the TechSmith Support Website link.  

 

Diagnostic Information 
When working with technical support, you could be asked to email or fax Camtasia Studio diagnostics.  

If so: 
1. Select Help > Support. 
2. The diagnostic information is highlighted. Click Copy to Clipboard and paste the information into an e-mail 

message, along with any other information requested by the Technical Support team. 

Alternatively: 
3. Save the diagnostic information to a file by clicking Save to File, then attach the file to the e-mail or print the data 

and fax (+1 517.913.6121) it to Camtasia Studio support, along with any other information requested by the 
Technical Support team. 

4. Click OK to close the Camtasia Studio Support window. 

 

Mailing Address  
TechSmith Corporation 
2405 Woodlake Drive 
Okemos, MI 48864 USA  

 

Telephone 
Toll free: 800.517.3001 (USA Only)  

Voice: 517.381.2300 

Fax: 517.381.2336 

 

TechSmith Support Links 
• For more information on Camtasia Studio, visit our homepage at 

http://www.techsmith.com/products/studio/default.asp.  
• For the most up to date FAQs, visit http://www.techsmith.com/products/studio/faqs.asp.  
• For information on TechSmith's upgrade policy, visit 

http://www.techsmith.com/products/upgrade/default.asp.  
• To find out about TechSmith's products, visit http://www.techsmith.com.  
• For Frequently Asked Questions, visit http://www.techsmith.com/products/studio/faqs.asp. 
• Download a free evaluation copy of Camtasia Studio at  

http://www.techsmith.com/Camtasiastudiofreetrial. 

 

 

 

http://techsmith.custhelp.com/cgi-bin/techsmith.cfg/php/enduser/std_alp.php
http://www.techsmith.com/products/studio/default.asp
http://www.techsmith.com/products/studio/faqs.asp
http://www.techsmith.com/products/upgrade/default.asp
http://www.techsmith.com/
http://www.techsmith.com/products/studio/faqs.asp
http://www.techsmith.com/download/studiodefault.asp?lid=DownloadCamtasiaStudio
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